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FOREWORD

This manual is intended as a style guide for authors who are preparing manuscripts for 
publication in the museum’s scientific serials. It represents a comprehensive revision of 
the Style Manual prepared in 1988 by Brenda Jones, then Managing Editor of the Amer-
ican Museum of Natural History’s scientific publications. The subsequent adoption of 
electronic text and image processing necessitated many changes in manuscript prepara-
tion and formatting, although long-time authors will find that most aspects of our house 
style remain much the same as in the past. Significantly, however, submission guidelines 
have been removed from the style manual and are now available only on the webiste.

In this regard, it is worth noting that, although our AMNH Bulletin series began publi-
cation nearly 130 years ago, it was not until 1918 that the first style manual, General Rules 
for the Preparation of Manuscript, was issued by entomologist and AMNH curator Frank 
E. Lutz (who also served as the first editor of Novitates). A mere 14 pages in length, this 
document set the standard for all AMNH style sheets that followed, including two by 
Ruth Tyler (1943 and 1953) and the last by Brenda Jones. Brenda apparently judged that 
the two versions prepared by Ruth Tyler constituted a single “edition” when she styled her 
pamphlet as the “Third Edition.” Following Brenda’s example, I shall consider her numer-
ous Internet-based updates as an extension of her printed work, making this revision, 
along with its anticipated electronic updates, parts of an ongoing Fourth Edition.

Mary Knight, October 27, 2009
revised May 2, 2014
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The American Museum of Natural History 
(AMNH) publishes three scientific serials: the Bul-
letin of the American Museum of Natural History, 
American Museum Novitates, and Anthropological 
Papers of the American Museum of Natural History. 
Both the Bulletin and the Novitates report research 
results in zoology (primarily systematics), as repre-
sented by the AMNH divisions of Invertebrate Zo-
ology, Paleontology, and Vertebrate Zoology (Her-
petology, Ichthyology, Mammalogy, Ornithology). 
Whereas the Bulletin is intended for monographic 

studies, the Novitates comprise shorter works. The 
Anthropological Papers are devoted to topics in an-
thropology as represented by the museum’s Divi-
sion of Anthropology.

The following sections provide information 
about acceptable manuscript and illustration for-
mat and style for each of these serials. For other 
information concerning submission procedures, 
editorial policy, including page charges, copyright 
and other policies, please consult the museum’s  
Scientific Publications website.

Section 1
Introduction
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GENERAL GUIDELINES: 
FILES FOR SUBMISSION 

Currently, one single-sided, double-spaced hard 
copy of the final accepted manuscript (text and cap-
tions) plus any tables and a printout of each figure  
must be submitted along with the electronic files. 

The electronic version of the text should be dou-
ble-spaced, including the references. Use 12 point 
Times New Roman or Times font throughout, and 
do not justify right-hand margins. Page numbers 
should be inserted only in the upper right-hand 
corner. 

In general, format standard text (e.g., all caps; 
caps and small caps; italics) according to recently 
published issues of the Novitates, Bulletin, or An-
thropological Papers. Format “special” text sections 
(i.e., those for which there is no previously printed 
example) in the style intended for the published 
document.

ORDER OF MATERIAL

Manuscript components should be organized in 
this sequence:

1. Text
2. References
3. Figure captions
4. Footnotes (if not embedded)
5. Appendices
6. Tables

Text, references, figure captions, footnotes, and 
appendices must be prepared using Word, but ta-
bles may either be prepared using Word or Excel 
(see Section 5 / TABLES, below). Items 1–4 above 
should be included in a single Word file. Appendi-
ces may also be included if none have landscape-
formatted pages. Tables may be included if they 
are few and none is formatted for landscape view. 
However, if any appendix is formatted for land-
scape, then all of the appendices should be placed 
together in a separate document, and the same rule 
applies to tables if any are landscape formatted.

Using Word

Scrupulous conformity to keyboarding conven-
tions in Word can greatly speed up the production 
process and result in more timely publication. Fol-
low these dos and don’ts while preparing manu-
scripts to minimize production delays:

1. Use paragraph spacing (accessible through 
the “Format” menu of Word or by using the split 
arrow in the upper left-hand corner of the docu-
ment) or the tab key to indent the beginning of 
each paragraph. Do not insert extra letter spaces to 
indent or align text.

2. Use a single hard return at the end of each 
paragraph, and use Word’s “hanging indent” option 
to create “hanging paragraphs” (e.g., for references 
and other lists). Do not use hard returns and tabs 
for this purpose.

3. Format words that need to be italicized as ital-
ics. Do not use underlining.

4. For dashes, use either Word’s en-dash (acces-
sible through “Insert>Symbol” and through specif-
ic shortcuts for your computer; to indicate intervals 
in numeric or alphabetic sequences) or the em-
dash (for grammatical punctuation, or to indicate 
missing entries in tables). Do not use two or three 
hyphens in a row for these purposes.

5. Use ordinary font for ordinal numbers (e.g., 
21st century). Do not use superscripts (e.g., write 
21st century, not 21st century).

6. Do not embed any comments in Word docu-
ments.

7. Do not use any field codes (e.g., to count en-
tries in a list or to automatically generate a table of 
contents).

8. Use appropriate Word symbols whenever pos-

Section 2
Formatting the Text
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sible (e.g., ° for degree, not a superscript “o”).

9. For further guidelines, see also Section 3 / 
Text Preparation: Style, which includes a section 
on Punctuation.

ESTIMATING LENGTH OF PRINTED TEXT

For a variety of reasons authors may want to es-
timate the length of their published work, especial-
ly since length may be the deciding factor in wheth-
er the work is published as an issue of Novitates or 
Bulletin. A long zoological manuscript, for exam-
ple, may be formatted as a Bulletin (normally ≥ 80 
printed pages), whereas shorter manuscripts may 
be formatted as Novitates (normally < 80 printed 
pages).  There are two approximate methods to es-
timate the length of printed text from manuscripts: 
(1) divide the total number of words in your man-
uscript text—obtainable using the Word Count 
tool in Word—by 650, or (2) divide the number of 
double-spaced (US Letter) text pages by 2.5. Ob-
viously, additional pages will be needed for figures 
and tables, but no concise estimation rules can be 
provided here. Inevitably, it will be hard to know 
whether some manuscripts should be formatted as 
Bulletins or as Novitates (the primary difference in 
the two is in the format of the title page). When in 
doubt, follow Bulletin formatting conventions. 

MAIN ELEMENTS OF THE TEXT

Title. The title should be centered on the page 
in upper and lower case for Novitates; for Bulle-
tins, the title should appear in upper case. The title 
should clearly indicate the subject matter, but be 
concise. Titles of taxonomic manuscripts should 
include the name of the major groups treated us-
ing the appropriate scientific name(s) or widely ac-
cepted vernacular equivalents. 

Author’s name and affiliation. Author(s) 
may spell out their given name(s) or use initials 
according to personal preference. In the Bulletin 
and Anthropological Papers, institutional affili-
ations are centered in italics below each author’s 
name. In Novitates they are indicated by footnotes 
that should be embedded using Word's automatic 
footnote maker or placed with the other footnotes 
at the end of the manuscript (see below). For the 
affiliation, authors should provide only the institu-
tion's name (the divisional or departmental name 
may also be included). Because mailing addresses 

are anachronistic and email addresses are ephem-
eral, this information is no longer printed in the 
AMNH scientific series.

Table of contents. Issues of the Bulletin and 
long Anthropological Papers normally have a table 
of contents. Issues of Novitates no longer include 
tables of contents. Do not use field codes to gener-
ate tables of contents automatically from electronic 
files.

Center the main headings (Level 1, see below)  
and indent subheadings (Levels 2 and 3) with tabs. 
Headings in the table of contents should corre-
spond exactly to headings used in the text (unless 
the latter are very long). It is sufficient to list the 
headings without the page numbers, but if pages 
must be indicated at the manuscript stage, use au-
tomated dot leaders to manuscript page numbers 
rather than those manually typed.

On rare occasions, it may also be desirable to 
supply a list of tables, illustrations, and/or maps 
(also with automated dot leaders and manuscript 
page numbers). Such lists should follow the table of 
contents.

Abstract. An abstract is required for all 
AMNH publications. The abstract, a concise sum-
mary of the main points of the manuscript, should 
be intelligible as stand-alone text (that is, without 
reference to the body of the paper). Abstracts of 
taxonomic studies should include the names of all 
new taxa described in the text (do not refer to “new 
species 1”, “sp. nov. 2,” etc.). Normally, the abstract 
should be kept to one page or less (ca. 1900 char-
acters or fewer in the Novitates, ca. 5000 characters 
or fewer in the Bulletin). Strive to include in the ab-
stract all relevant words or phrases that might be 
used for web-based searches.

Introduction. The introduction may be for-
matted as a single block of text, or sections may be 
distinguished by subheadings. Typically, “Materials 
and Methods” is included as a Level 2 subheading 
near the end of the Introduction, and some authors 
include an additional subheading (e.g., “Abbre-
viations”) for lists of institutional acronyms and/or 
abbreviated scientific terms (optionally, anatomi-
cal abbreviations used repeatedly in figures may 
be listed in an appendix). Recent issues of AMNH 
publications will provide relevant examples of ac-
ceptable formats for these items. 

Acknowledgments. An acknowledgment sec- 
tion should be included at the end of the text (im-
mediately preceding the References). Honorific ti-
tles (Dr., Mr., Ms.) should not be used in the body 
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of the text and should be avoided in the Acknowl-
edgments.

HEADINGS IN THE TEXT

AMNH publications typically employ three lev-
els of text heading. The following list provides for-
mat specifications and recommended uses for these 
standard subdivisions. Note that formatting can 
also be applied, if necessary, to highlight certain re-
peated categories of information within paragraphs 
(see Headings within paragraphs).

Level 1 headings: These are typically used for 
main sections of the text, such as the Abstract, In-
troduction, Results, Discussion, and References. 
Format these as centered headings, all in capital 
letters (e.g., Introduction). 

Level 2 headings: These are centered with ini-
tial capital letters for nouns and the rest small caps 
or lower case (e.g., Materials and Methods).

Level 3 headings: These are paragraph in-
dented, with large initial capitals and small capitals 
(e.g., Sequencing methods), normally followed 
by a colon and run into the text.

Headings within Paragraphs

Within paragraphs, various formatting options 
allow for highlighting words or phrases that effec-
tively serve as headings. These include (1) all capi-

tals, (2) boldface, (3) small capitals, or (4) italics. 
Do not use underlining for any heading; it must 
be replaced with another format more suitable for 
printing. Use within-paragraph headings in a con-
sistent way throughout the manuscript. These are 
typically employed to distinguish certain elements 
in the text that are used repetitiously, for example, 
countries and/or states in lists of specimens exam-
ined, or characters in taxon diagnoses.

FOOTNOTES

Number text footnotes consecutively through-
out the manuscript using superscripted Arabic 
numerals. Although useful for many scholarly 
purposes, footnotes should be kept to a mini-
mum because they complicate the page composi-
tion process. However, Novitates authors must use 
footnotes for institutional identification on the 
title page. Body-text footnotes may either be gath-
ered together in a separate section following the 
figure captions (see Order of Material, above), or 
they may be entered into a Word document using 
Word’s automatic footnote maker. 

For tables with footnotes included in the same 
Word document as the body of the article, do not 
use Word’s automatic footnote maker. 

Apart from those for authors' affiliations in No-
vitates, footnotes may not be used in any chapter 
title or section heading; they are also not permit-
ted in the titles of tables, though they may appear 
in table captions.
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Section 3
Text Preparation: Style

(e.g., from anterior to posterior).
Although a concise style shortens the text, thereby 

helping readers extract information quickly, clarity 
should never be sacrificed. Information should be 
presented in the most concise way without causing 
confusion or changing the meaning.

Telegraphic style. Sentences written in so-
called telegraphic style typically consist of a subject 
(usually a noun) followed by a descriptive modi-
fier that may be adjective(s), simple descriptive 
phrase(s), or subordinate clause(s). 

The following tips may be helpful in the process 
of condensing:

1. “Tighten” the text (i.e., delete all unnecessary 
words)

2. Omit certain parts of speech that can be 
understood in context without ambiguity, e.g., 
articles and verbs. Thus, remove all instances 
of “the” except where absolutely necessary to 
preserve meaning. 

3. Delete all forms of the verb to be. Wherever 
practical, change remaining verbs to a 
participial form (-ing and -ed endings), which 
allows them to modify nouns.

4. Include only critical verbs. These normally occur 
in subordinate clause or in parenthetical 
sentences.

Tense. The following guidelines are suggested 
for resolving past versus present tense decisions. 
When exceptional situations arise authors must 
rely on common sense.
1. Use the past tense for completed events. This 

applies almost universally if an author is 
the subject of the verb: use “Segall (1971) 
observed” not “Segall (1971) observes.”

2. The present tense (known as the universal 
present) should be used for all published 
experimental results (which are regarded as 
established knowledge) and for all discussions 
and conclusions about both published and 
unpublished material. For example, “Segall 
(1971) observed that the ectotympanic in 

For general aspects of style not described in this 
manual (e.g., preferred English usage, capitalization, 
and punctuation), authors should consult The 
Chicago Manual of Style and Words into Type. For 
spelling, refer to Merriam-Webster’s 11th Collegiate 
Dictionary and Webster’s Third New International 
Dictionary. See also Spelling, Abbreviations, and 
Special Notation for lists of exceptional words, 
scholarly and nontechnical abbreviations, units of 
measure, and technical abbreviations adopted for 
use in AMNH Scientific Publications.

ECONOMICAL PRESENTATION

Authors should present all material (text, tables, 
illustrations, and appendices) as concisely as 
possible. Irrelevant material detracts from a paper 
and increases the cost of production. Consider, for 
example, whether it is necessary to present all data in 
tabular form—would a few summarizing sentences 
be sufficient? Is it necessary to detail previously 
published results or would a brief reference to such 
material be just as effective? Because the purpose of 
publication is to communicate, obfuscating jargon 
should be avoided.

English language. The AMNH Scientific 
Publications are in English. Except for quoted ma-
terial, all parts of the manuscript must be in Eng-
lish. Non-English abstracts are no longer allowed.

Condensed text. In text that introduces or an-
alyzes data, an abbreviated style is not appropriate. 
However, sections devoted solely to supplying data 
are candidates for condensed presentation. For ex-
ample, lengthy morphological descriptions given 
taxon by taxon in the Bulletin and Novitates are of-
ten most efficiently communicated in the so-called 
telegraphic style. In the Anthropological Papers, a 
condensed style should be considered for long sec-
tions devoted to physical descriptions of artifacts.

Similar items described in successive sections 
of condensed text should be mentioned in the 
same order and punctuated the same way for easy 
comparison. In taxonomic revisions this means 
that descriptions of coordinate taxa address the 
same anatomical characters in the same sequence 
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Icaronycteris is annular” (is not was) How-
ever, the past tense should be used if the results 
are being discussed in a historical context or if 
results no longer apply (e.g., when describing 
an extinct group).

3. The past tense is preferred when reporting  
your own present experimental methods and 
results. The basis for this recommendation is 
that your current material is not considered 
established until published. For example, 
“We measured 18 parameters. Within-habitat 
variation in L. irrorata density was predictably 
correlated with Spartina density.”

PUNCTUATION

The Chicago Manual of Style or Words into Type 
should be consulted for general questions about 
punctuation not addressed herein.

Comma. Use the serial comma (i.e., place 
a comma before the final and or or in a series of 
items). For example, “Bulwer’s (1846) descriptions 
were prolix, inconsistent, and inaccurate.”

Period. Most abbreviations require a period 
to indicate that the word is abbreviated, unless it 
is a capitalized acronym. For example, Mar. (for 
March), but LDV (for lower discocellular vein).

Tabs. Tabs may be used to indent paragraphs 
(or use the Format>Paragraph option from the 
drop-down menu of Word). Also, use single tabs 
between columns in tables.

Tabs versus dot leaders. Tabs may also be 
used to replace dot leaders in tables of contents, 
keys, and the like. (To insert dot leaders, use the 
Format>Paragraph>Tabs or Format>Tabs option 
in Word’s drop-down menu; in most versions of 
Word, dot leaders are option no. 2.)

Line and letter spaces. Do not set off 
paragraphs a block of text with line spaces, although 
headings may appropriately be marked with a line 
space before and after. Do not add an extra letter 
space after sentences and do not create paragraphs 
with multiple letter spaces (see Tabs, above).

Capitals. In accordance with The Chicago 
Manual we have adopted a “down” style—the 
“parsimonious use of capitals.” Words should not 
be capitalized without good reason:

“There is considerable variation in 
the length of the lower discocellular 
vein” (the author uses the capitalized 
abbreviation LDV elsewhere, but 

when spelled out the words “lower 
discocellular vein” should not be 
capitalized).

Do not capitalize the category words of multiple 
proper nouns, e.g., the Nile and Amazon rivers (but 
use “Nile River” and “Amazon River” separately).

Use a capital N to designate sample size (e.g.,  
N = 215).

The words “figure,” “table,” and “appendix” 
should be capitalized only at the beginning of 
sentences, as the first word in any line of a heading, 
or the first word of any caption.

Caps vs. small caps. Any title that should be in 
caps and small caps can be set by the authors in caps 
and small caps in the manuscript Word document 
(Font>Font, select small caps). Do not use capital 
letters in place of small caps, and do not create your 
own small caps by setting regular capital letters a 
smaller size.

Time abbreviations: a.m. and p.m. and b.c. and 
a.d. should be set as small caps; for authors who 
cannot generate small caps in a document, please 
leave them lowercased.

Subscripts and superscripts. Necessary 
subscripting and superscripting should be done 
by the author, e.g., CCl4, H2O, 16 m2. (But do not 
superscript ordinal numbers, e.g., 21st not 21st.)

Quotation Marks

Several important conventions must be followed 
regarding the use of quotation marks. Manuscripts 
that do not conform with these guidelines will be 
returned to the authors for correction.

1. Use double quotes for all direct quotations and 
for “scare quotes” (see below). Single quotation 
marks are used only for quotes within quotes:

Menzies (1990: 132) revised Pogono-
melomys, excluding ruemmleri from it 
and making it the type species for the 
new genus Coccymys (“from the Greek 
coccyx and mys, ‘cuckoo-mouse’ with 
reference to spending its early taxo-
nomic life in a place not its own”).

2. Final punctuation must be included within the 
closing quotation mark.

3. If very brief, quoted material may be preceded 
by a comma or by no punctuation at all if it 



is incorporated into a sentence. However, if 
the quoted material comprises a sentence or 
more, it should be preceded by a colon, and 
if it requires 4 or more lines in manuscript 
it should be set off from the main text with 
a line space above and below the extract. 
Indent the left margin of the extract (use the 
Format>Paragraph option on the Word menu 
to reset the margin for the extract) so it is set 
off from the main text; authors may create a 
new Word style (Format>Style) if extracts are 
frequently used in a single manuscript. Use 
double quotation marks for quotations within 
quotations that have been set off as extracts. 
Be sure to use square brackets around any 
information or qualifying remarks that you 
insert into a direct quotation. If the quoted 
material is marked off by double quotation 
marks, use single quotation marks for 
quotations within it.

4. Use double quotation marks around terms used 
in an unusual sense (“scare quotes”). Italics, 
rather than quotation marks, are preferred 
for new terms that are introduced or defined 
in situ. The English translation of a foreign 
term should be enclosed in double quotation 
marks. The foreign term being defined should 
be in italics.

Hyphenation

In general, avoid grammatically unnecessary 
hyphens, which tend to clutter the page with 
distracting type. However, if a word is defined 
with a hyphen in the dictionary and it is not on 
our list of exceptions, follow the dictionary (e.g., 
“pitch-black”). Likewise words may need to be 
hyphenated to avoid ambiguity, e.g., small-winged 
termite (insect, perhaps of normal size, but with 
small wings) vs. a small winged termite (insect 
small, with wings).

Compound adjectives. Perhaps the most 
misunderstood rule of hyphenation has to do with 
compound adjectives. Simply stated, if a compound 
adjective of two or more words precedes a noun, 
the compound is hyphenated; if it comes after its 
noun, it is not hyphenated:

a three-year interval (before the noun)
an interval of three years (after the noun)

a well-developed molar (before the noun)

a molar that is well developed (after the noun)

It may not be evident that two words modify-
ing a noun respresent a single compound adjective, 
and there is indeed a difference in meaning. Note 
the following:

long-furred porcupines: porcupines with long 
fur, vs.

long furred porcupines: a porcupine lineage 
whose furred character dates back a long 
time.

Note that some adjectival phrases that include 
“well” are defined in the dictionary with a hyphen 
(e.g., well-defined), so the hyphen remains even 
when the modifying phrase follows the noun.

There are several exceptions, the most significant 
of which is when an adverb ending in -ly is the first 
word of the compound modifier. Because the adverb 
actually modifies the adjective (not the noun), and 
because words ending in -ly can function only as 
adverbs, the hyphen is clutter:

variously colored moths (not variously-colored 
moths)

Many adverbs not ending in -ly, however, often take 
a hyphen:

little-understood system
best-known coleopterist of the 18th century

To avoid confusion, use the hyphen when letters 
are used in compound adjectives, even when they 
follow the noun they modify:

a V-shaped notch
a notch that is V-shaped

Compass points. Close up compass points 
like northeast, southwest, etc., except when three 
compass points are compounded thus: north-
northeast, south-southwest.

Spelled-out fractions. Do not hyphenate 
noun forms of fractional units (e.g., a half hour, 
a quarter mile). In text passages dense with data, 
authors have the option of using decimal fractions 
(e.g., 0.5 hour, 0.25 mile; see also Spelled or 
glyphed?).

Prefixes. So-called combining prefixes and 
standard biological prefixes do not take a hyphen 
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except to avoid confusion (e.g., between re-cover 
and recover). A hyphen may be used when the same 
vowel is doubled in a technical term (e.g., spino-
occipital), or the author(s) may prefer to apply the 
rule uniformly (spinooccipital). Each manuscript, 
however, must be internally consistent and not vary 
from page to page (except for quoted text). If an 
author submits a work with variations (e.g., “spino-
occipital” on p.1, but “spinooccipital” on p. 2), the 
editor will normalize all relevant examples to the 
unhyphenated form (spinooccipital). 

Examples of prefixes that should normally be 
closed up rather than hyphenated: 

antero-, anti-, bi-, bio-, co-, dorso-, 
extra-, infra-, intra-, inter-, latero-, 
macro-, micro-, mid- mini- non- post- 
postero-, pre- pseudo- re- semi- super-, 
supra-, trans-, ultra-, under-, ventro-

down-, up- and the like are also often closed up: 
upturned, downcurved.

-like words. The suffix -like is closed up to all 
words except technical terms, proper nouns, or 
words with more than three syllables (e.g., leglike, 
but epiphysis-like).

En-dash. The en-dash (slightly longer than 
a hyphen) is used in two major circumstances to 
indicate:

1. ranges (e.g., 17–36)
2. compounds with two (or more) word elements 

on a side (e.g., Minneapolis–St. Paul, but not 
Cretaceous-Tertiary boundary, where the 
hyphen is correct)

The en-dash dash can be inserted in Word docu-
ments in several ways, including shortcuts; the 
“long” way is to go to “Insert” on Word's drop-down 
menu and from there select “Symbol.” In most ver-
sions of Word, there are “Special Characters” listed 
from which one can choose the “En Dash” (the 
shortcut is also given there and can be redefined).

Em-dash. The em-dash (slightly longer than 
the en-dash) is used to indicate a break in syntax, 
and should thus be used sparingly. When inserted 
within a larger, framing syntactical structure, the 
em-dash should be used in pairs. 

Examples:
Such detailed research for a species 
sample of the size employed here 

would be a huge undertaking—a study 
unto itself.

Prout (1918) and Hering (1925) relied 
on a small set of superficial adult traits 
for taxonomic assessments—notably 
wing venation, wing pattern, antennal 
structure, and labial palpus shape—
most of which can be evaluated without 
the aid of a microscope.

The em-dash is also used to indicate missing 
table entries (see Section 5 / TABLES, below). Like 
the en-dash (above), the em-dash can be inserted 
in Word documents in several ways.

TREATMENT OF NUMBERS

Spelled or glyphed? In general, spell out cardi-
nal and ordinal numbers up to 10 (e.g., eight, eighth), 
fractions used as adjectives (e.g., one-half wing 
length), and any number that begins a sentence.

Exceptions:

1. series of numbers in condensed text such as 
keys, descriptions, or diagnoses written in 
telegraphic style

2. series of numbers within parentheses
3. enumerated parts (e.g., tergite 2, section 3, 

segment 2, etc.)
4. dates (e.g., 19th century)
5. stand-alone fractions, e.g., 11/4, etc. (see also 

Spelled-out fractions)
6. all units of measure
7. ordinal numbers used in references (e.g., 2nd 

ed.)

Special cases: follow the style of the largest number 
for all numbers in a series or related numbers in the 
same sentence.

Commas and decimals. Do not use commas in 
four-digit numbers (e.g., 5470). Always place a zero 
preceding decimal fractions (e.g., 0.03).

Spaces. Use a letter space between numbers and 
units of measurement, i.e., 79.8 km, not 79.8km.

Use a single letter space before and after 
mathematical symbols (+, -, =, <, >, ≤, ≥) in 
running text. Exception: close up to an open 
parenthesis when the symbol is the first (or the 
last) element within the parenthetical phrase, e.g., 
(= total males).

AMNH12 Section 3 / TEXT PREPARATION: STYLE
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Magnification. Type the multiplication sign 
(Insert>Symbol) preceding and flush to the mag-
nification number (e.g., ×10).

Dates. Do not use a comma after the month 
unless a day is given (e.g., July 3, 1959, but July 
1959). No apostrophe is to be inserted between the 
date and the terminal s when referring to a decade 
(e.g., 1940s, 1980s). Use standard abbreviations 
for months (Jan., Feb., Mar., Apr., May, June, July, 
Aug., Sept., Oct., Nov., Dec.) where dates are given 
repetitiously. See also Caps vs. small caps.

TEXT CITATIONS

Figures. Spell out “figure” when the word is used 
in running text, but use the abbreviation “fig.” within 
parentheses. “Figure” should be capitalized only at 
the beginning of sentences, as the first word in any 
line of a heading, or at the beginning of a caption.

Figures (as well as tables and appendices) 
should normally be cited in consecutive order 
within the main body of the text. If they are not, 
authors must indicate where they should appear in 
the text; otherwise the page compositor will insert 
them where first cited.

Citation format. In-text citations to works list-
ed in the references or to unpublished items should 
be cited according to the conventions and illustra-
tive examples below (see also Reference Style).

Put author and date in parentheses at the end of 
a sentence or other logical unit if the citation does 
not apply to the entire sentence:

(Rufus, 2006)
(Jones and Smith, 1984).

Use “et al.” for works with three or more 
authors: 

(Osborne et al., 1920).

Add a, b, c, etc., to the date for more than one 
work with the same author(s) and year; match with 
full citation in references:

(Beck, 1980a, 1980b, 1980c).

Cite references in chronological (not alphabeti-
cal) order:

(Anderson, 1916; Simpson, 1932; Patel, 
1968; Rakesh, 2004).

Authors of Anthropological Papers may have 
some justification for another arrangement, such as 
the order of importance or alphabetical order, but 
if an alternate arrangement is adopted, it must be 
applied consistently throughout the entire work.

Cite another author’s pages, figures, or plates 
using a colon (followed by a letter space):

(Auweyida, 2006: 45–234)
(Blair, 1902: figs. 3, 4)
(Pascal, 1954: 22, pl. V, figs. 2–9)

Unpublished work may be cited in the text 
without any listing in the references:

(Koulianos and Palmer, personal com-
mun.)

(Röschmann, unpubl.) 
(Akida, unpubl. data)
(López, in prep.) 
(Wong, personal obs.)

Cite chapters in books or other smaller 
contributions to larger works by referring to the 
author(s) of the chapter or smaller work, since this 
is the actual work that is cited: (Williams, 1934). 
Sometimes, however, it may be necessary to list in 
the References only the author, editor, or compiler 
of the larger work, in which case the smaller work 
may be cited in the text as follows: (Williams in 
Jones, 1934); see Reference Style.

Avoid citations that immediately follow 
Latin binomials, as these can be confused with 
attributions of author and date for the name. For 
example, the phrase “has been reported from 
Peromyscus maniculatus (Hooper, 1958)” could 
be interpreted as (1) attributing authorship of the 
species maniculatus to Hooper, or (2) attributing 
credit for the reported observation to the same 
source. If such constructions cannot be avoided, 
then the word “see” should be inserted (see Hooper, 
1958) to eliminate ambiguity. 

Always provide a page number for a quotation, 
using a colon followed by a letter space before the 
page number:

According to Kluge (1964: 13), 
Homonota uruguayensis has an “almost 
uniform grayish black coloration . . . 
unique within the genus.” 

Website citations. Authors who wish to 
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cite a website in the text without listing it in the 
references should include the complete URL plus 
the date accessed. Websites should be enclosed in 
parentheses so there is no confusion about the exact 
URL. (See also Websites under Reference Style.)

TAXONOMIC ACCOUNTS

Taxonomic accounts should be structured 
consistently (in format and style) throughout 
the manuscript. AMNH Scientific Publications 
currently permit considerable flexibility (e.g., for 
presenting synonymies; see below), but authors 
must adhere to a consistent format once one is 
adopted. Likewise, the style of taxon description 
must be consistent from account to account.

Hierarchies

Taxonomic hierarchies (more frequently used in 
paleontology than in other fields) may be presented 
in either of two ways: as a traditional, ranked 
sequence; or without any explicit indication of 
taxonomic rank. Note that taxon names (each with 
author and date) are typed as centered lines (each 
ending with a hard return) in both examples, 

Example of a ranked hierarchy:

class mammalia linneaus, 1785
order perissodactyla owen, 1848

family brontotheriidae marsh, 1873
subfamily brontotheriinae marsh, 1873

Bunobrontops savagei Holroyd 
and Ciochon, 2000

Example of an unranked hierarchy:

Squamata Oppel, 1811
Anguimorpha Fürbringer, 1900

Platynota Camp, 1923
Varanoidea Camp, 1923
Ovoo gurvel, new taxon

Note in the second example that the names of new 
taxa are set in boldface.

Synonymies

Format. As with hierarchies, there is more 
than one way to present synonymies, but certain 
features are constant. A complete bibliographic 

reference for each synonymy citation must be 
listed in the References. Only the author, year (and 
occasionally month and day), and page number(s) 
are required in the synonymy. Supply additional 
information (such as location, abbreviated 
descriptions, etc.), if needed, in parentheses at the 
end of each citation.

If the synonymy is new, the phrase “new 
synonymy” may be inserted at the end of the name 
newly synonymized.

Example 1:
Oreophrynella quelchii Boulenger: Gines, 1959: 135, 

138 (mention of a specimen from Auyantepui, 
with drawings of whole body, lateral head, 
hand, and foot).

Oreophrynella cryptica Señaris, “1993” [1995]: 178, 
fig. 1 (hand and foot). Holotype EBRG 2956 
from sector este, cima del Auyan-tepui, Estado 
Bolívar, Venezuela (5E53′36″N, 62E29′12″W), 
1750 m, collected February 10, 1994, by “J. C. 
Señaris and Petia Alcócerez [sic].”

Example 2:
Ocypus Montrouzier, 1861: 67, junior homonym 

of Ocypus Leach, in Samouelle, 1819: 172 
(Coleoptera). Type species: Ocypus variegatus 
Montrouzier, 1861, by monotypy.

Coridromius Signoret, 1862: 5 (nom. nov. for 
Ocypus Montrouzier, 1861). 

Neocypus Distant, 1914: 378 (unnecessary nom. 
nov. for Ocypus Montrouzier, 1861). Carvalho, 
1987: 61; Linnavuori, 1994: 15; Schuh, 1995: 
46; Cassis and Gross, 1995: 185; Liu and Zhao, 
1999: 55; Miyamoto and Yasunaga, 1999: 33; 
Chérot et al., 2004: 57.

Coridromoides Carvalho, 1956: 54 (new genus). 
Type species: Coridromoides carinatus 
Carvalho, 1956, by original designation.

Example 3:
Hadesina anomala Prout, 1918: 418.
Trochiodes coniades Druce, 1893: 309, pl. 21, fig. 

21.
Xenomigia Warren, 1906: 413.
Pareuchontha Miller, 1989: 30.
Lignyoptera monticolata Maassen, 1890: 42, n. 29, p. 

163, pl. 8, fig. 27.

Example 4:
Devara frigida Walker, 1864: 185.
Type Locality: Ecuador, Cuenca.
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Type: Syntype ♂, ex Fraser Collection (BMNH).

Macroneurodes albimacula Warren, 1900: 127.
Type Locality: Colombia, “Bogotá”.
Type: Holotype ♂ (BMNH).

Gnatholophia longinervis C. and R. Felder, 1874: pl. 
105, fig. 8.

Type Locality: Not known.
Type: Syntype ♂ (BMNH).
Euchontha sublactigera Walker, 1865: 383.
Type Locality: Colombia, “Bogotá”.
Type: Syntype ♂, ex Stevens Collection (BMNH).

Taxonomic names. Note that each name 
in a synonymy should be typed flush to the left 
margin and any lines that run over should be 
hang-indented a standard number of spaces 
below the first line (Format>Paragraph: look for 
“Indentation” then “Special”).

Name(s) of author(s). The scientific name and 
the author’s name must not be separated by any 
intervening punctuation if the author originated 
the name in the cited work. For example:

Hystrix insidiosa Olfers, 1818: 211. [original 
description]

However, the scientific name and the author’s 
name must be separated by a colon if the author 
did not originate the name in the cited work. For 
example:

Coendou insidiosus: Trouessart, 1897: 623. [name 
combination]

Because works cited in synonymies must ap-
pear in the References section, it is not necessary 
to list all the authors of a taxon. For names with 
three or more authors, use only the first author’s 
name followed by “et al.” For example:

Oryzomys tatei Musser et al., 1998: 100. 

Dates, pages, illustrations. A comma 
should be placed after the author and before 
the date. There should be a colon after the date, 
followed by a single letter space, and then the 
page number. Normally the page number is only 
the first page that establishes the synonymized 
usage.

In citing figures, plates, parts, note numbers, 

and the like, convert Roman numerals to normal 
Arabic ones, unless this would result in confusion. 
Abbreviate the words for figure, plate, and part 
(i.e., fig., pl., pt., n.).

Abbreviation of generic names. A generic 
name (e.g., Peromyscus) must be spelled out 
(1) the first time the genus is mentioned in a 
paragraph or caption, and (2) at the beginning of 
any sentence. Elsewhere, a generic abbreviation 
is acceptable as part of a binomial combination 
(e.g., P. maniculatus).

Keys

The following examples show three of several 
acceptable formats. Others can be found in recently 
published issues of Novitates and the Bulletin. 

Example 1:
1. Forewing with a full compliment of radials pres-

ent (R1, Rs1–Rs4)...........................................  3
– FW with only four radials present (figs. 221F, 

232C)................................................................. 2
2. Forewing vein Rs1 arising from radial sector (fig. 

221F); FW uniformly gray to gray-brown (pl. 
21), or FW gray-brown with a large white tri-
angle along anal margin (pl. 22); FW length 
= 9.0–12.0 mm................ Dolophrosyne Prout

– FW vein Rs1 arising from anterolateral angle of 
DC (fig. 232C); FW light brown with a faint, 
cream-colored dash along anal margin (pl. 
22); FW length = 11.0–12.9 mm .....................
Xenormicola extensa (Hering)

3. Forewing vein Rs1 stalked with Rs2–Rs4; FW 
pattern variable, sometimes cryptically col-
ored...................................................................  5

– FW vein Rs1 arising from anterolateral angle of 
DC (figs. 38A–C, 70F), widely separate from 
Rs2–Rs4; FW brightly colored......................  4

Example 2:
1. Proepisternum bilobed (figs. 3C, 18A); metano-

tum prominent and flared (fig. 16C–D)....... 2
– Proepisternum unilobed (fig. 3C); metanotum 

not prominent and flared (fig. 13D)............17

2. Metepimeron punctate (figs. 13A, 19A–B); right 
paramere club-shaped with short, rounded 
process, appearing U-shaped from above 
(figs. 10B–D)..................................................... 3

– Metepimeron impunctate (fig. 8E); right paramere 
not club-shaped, not appearing U-shaped 
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when viewed from above................................ 6
. . .

4. Male left paramere tightly corkscrewed (figs. 
17H, 19E–F); female possibly with cork-
screwed paragenital opening on right side of 
abdomen (fig. 19B–C)..................................... 5

– Known only from females, female without any 
visible paragenitalia; male suspected to not 
have corkscrewed left paramere (South Chi-
na, Laos, Nepal, Sumatra, Vietnam)................ 	
............................................................. testaceous

Example 3:
1a. Anal-fin spines number seven or greater (fig. 

19C); pelvic axillary scale present (fig. 23); 
scale ridges (“sheathing”) present on dor-
sal and anal fins near base and free from fin 
membrane on spiny portions of both fins (fig. 
22); scales cycloid............................................. 2

1b. Anal-fin spines number three (or rarely 
four) (fig. 19A–B); absence of pelvic axillary 
scale (fig. 21A–B); absence of scale ridges 
(“sheathing”) along dorsal- and anal-fin bases 
(fig. 21A–B); scales mostly ctenoid (except 
Paratilapia, which is variable for this feature) 
variable for this feature)………………... 3

2a. Oral dentition unicuspid, spatulate in shape; a 
single row of teeth in both upper and lower 
jaws; teeth few in number (< 18 in upper jaw, ≤ 
14 in lower); upper-jaw teeth on either side of 
premaxillary symphysis greatly enlarged (figs. 
3B, 4D, and 5A) …………………..…….........
Paretroplus

2b. Oral dentition tricuspid (both inner and out-
er rows); teeth present in multiple rows in 
both upper and lower jaws; teeth numerous 
(in much greater numbers than Paretroplus) 
on both upper and lower jaws (fig. 4C) 
…………………..................................Etroplus

Subheadings

After each centered taxonomic heading and 
synonomy (if included), a series of subheadings 
normally follow, usually in Level 3 format (large 
and small caps followed by a colon and run into the 
text; see above). These subheadings often include 
such items as:

Type material
Type locality

Distribution
Contents
Diagnosis
Description
Etymology
Specimens examined. 

Although there is considerable flexibility 
concerning which of these subheadings is used, 
and in what sequence (recent issues of the Novitates 
and Bulletin contain numerous examples), certain 
categories of information must be provided for new 
names to be available under the International Code 
of Zoological Nomenclature (ICZN, 1999), and 
manuscripts containing taxonomic accounts that 
lack essential information or that do not conform 
with widely accepted standards may be returned to 
authors for revision. 

SPELLING, ABBREVIATIONS, AND SPECIAL 
NOTATION

When in doubt, authors should consult 
Merriam-Webster’s 11th Collegiate Dictionary or 
(for technical terms not found in that reference) 
Webster’s Third New International Dictionary of 
the English Language, Unabridged. AMNH usage, 
however, sometimes differs from these sources, and 
the following lists provide a guide to such cases, as 
well as commonly used abbreviations.

Preferred Spellings (see also Hyphenation)

artifact (not artefact)
archaeology
braincase 
catalog (not catalogue)
cheektooth (adj. and noun)
database
dataset
Eastern Hemisphere 
fieldnotes 
fieldwork
fin ray (noun) fin-ray origin (“fin ray” functions as 

adj.)
fin spine (noun)
focused
forelimb, forewing (fore- is a combining form
freshwater (adjective)
fresh water (noun)
gray (not grey)
groundwater
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hemal (not haemal)
hind limb, hind wing (hind is not a combining 

form)
homolog (not homologue)
labeled
leaf-litter (adjective preceding noun) 
leaf litter (noun)
nomenclatural
online
rainforest (adjective preceding a noun)
rain forest (noun)
saltwater (adjective preceding a noun)
salt water (noun)
sister group (noun)
sister-group (adjective)
toothrow (adj. and noun)
toward (not towards)
website
Western Hemisphere

Abbreviations

Do not italicize familiar Latin and other foreign 
words and phrases. Use italics only if the foreign 
term is likely to be unfamiliar to the reader; if the 
word appears in a standard English dictionary, 
do not italicize. Do not use unnecessary Latin 
abbreviations when the English is common, e.g., 
use “above” rather than “supra” and “below” rather 
than “infra.”

° 	 degrees: use symbol; do not spell 
out

°C	 degrees Celsius (“centigrade”)
°F 	 degrees Fahrenheit
′, ″	 minutes, seconds (of latitude and 

longitude; use prime and double 
prime symbols from Word’s 
“Symbol” menu)

♀	 “female” is preferred to ♀ in 
running text unless repetitious. 
Use one symbol for enumeration, 
e.g., 4♀. (Word: Insert>Symbol)

♂ 	 “male” preferred to ♂ in running 
text unless repetitious. Use one 
symbol for enumeration, e.g., 
3♂. (Word: Insert>Symbol)

Å 	 angstrom
a.d 	 anno domini (years after Christ, 

lit. “in the year of [our] Lord”) 
ad hoc	 Lt. “for this”; for this particular 

case
aff. 	 affinis 
AMNH 	 American Museum of Natural 

History (and abbreviate other 
institutions if repeated more 
than a few times)

anon.	 anonymous
art.	 article
b.c. 	 before Christ
b.p. 	 before the present 
ca.	 circa
cc	 cubic centimeter
cf.	 (Lt. confer) compare
chap.	 chapter
cm 	 centimeter
col.	 column
cps 	 cycles per second
cu	 cubic
CV 	 coefficient of variation
day	 spell out
db 	 decibel 
df 	 degrees of freedom
diss.	 dissertation
doz.	 dozen
e.g.	 (Lt. exempli gratia) for example
elev.	 elevation (do not use a.s.l.)
eq.	 equation
et al.	 (Lt. et alii) and other (people)
et seq.	 (Lt. et sequentes) and the 

following
eV 	 electron volt
ex.	 example
fasc.	 fascicle
fig.	 figure; use “figure” outside 

parentheses, “fig.” inside
fn.	 footnote
ft 	 foot
g 	 gram
gal 	 gallon
Gr.	 Greek
ha 	 hectare
hr (hour) 	 spell out unless repetitious
Hz 	 Hertz
i.e.	 (Lt. id est) that is
ibid.	 (Lt. ibidem) in the same place 

(used exclusively in citations and 
footnotes)

in litt.	 in a written communication (e.g., 
in a letter).

in vitro	 Lt. “in the glass” (i.e., outside the 
living animal)

in vivo	 Lt. “in the living”
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in. 	 inch
incertae sedis	 Lt. “of uncertain place” (i.e., in a 

taxonomic grouping)
kg 	 kilogram
kH 	 kilohertz
latitude 	 spell out unless repetitious 

(0°10′N latitude)
liter 	 (spell out)
loc. cit.	 (Lt. loco citato) in the place cited
longitude 	 spell out unless repetitious 

(20°11′W longitude)
Lt.	 Latin
m 	 meter
m.y. 	 million years
Ma, Mya 	 megaannum, million years ago 

(or mybp; be consistent)
mg 	 milligram
mi	 mile
min (minute)	 spell out unless repetitious
ml 	 milliliter 
mm 	 millimeter
mo (month)	 spell out unless repetitious
mp 	 melting point
ms (plural mss)	 manuscript(s)
mybp 	 million years before the present 

(also Ma; be consistent)
N 	 number (database)
n. ser.	 new series
n.d.	 no date
n.p.	 no place; no publisher
nomen dubium	 Lt. “doubtful name” (plural 

nomina dubia) 
nomen nudum	 Lt. “naked name” (plural nomina 

nuda) 
nomen oblitum	 Lt. “forgotten name” (plural 

nomina oblita)
o. ser.	 old series
op. cit.	 (Lt. opera citato) in the work 

cited above
p or P 	 probability
p.	 page (plural pp.)
percent 	 use sign (%)
personal commun.	personal communication
personal obs.	 personal observation
pH 	 measure of acidity or alkalinity
Ph.D.	 (Lt. philosophiae doctor)
pl.	 plate
pt.	 part (but spell out “in part”)

publ.	 published
r or R 	 correlation coefficient
rpm 	 revolutions per minute
s.l.	 sensu lato (abbreviate if 

repetitious)
s.s.	 sensu stricto (abbreviate if 

repetitious)
SD 	 standard deviation
SE 	 standard error
sec (second)	 spell out unless repetitious
SEM	 standard error of mean; scanning 

electron microscope
sensu	 Lt. “in the sense of”
sensu lato	 Lt. “in the broad sense” (or s.l.; 

be consistent)
sensu stricto	 Lt. “in the narrow sense” (or s.s.; 

be consistent)
ser.	 series
suppl.	 supplement
unpubl.	 unpublished
vol.	 volume
vs.	 spell out versus unless 

repetitious
year	 spell out
μm 	 micrometer

Authors citing themselves within the body of 
their papers should use their initials separated 
by periods to distinguish personal names from 
acronyms of organizations; for example:

Histological examination was carried out by 
two of us (F.D.A. and G.P.S.).

Mammalian Dental Notation

Although several alternative notational systems 
are current in the literature, AMNH style uses upper 
and lower case letters followed by Arabic numbers 
(without super- or subscripting) to indicate 
mammalian dental loci. For example, use M3 (not 
m3 or M3) for the third upper molar and m3 (not 
m3 or M3) for the third lower molar, with plurals 
M3s and m3s. To avoid ambiguity, always spell out 
dental loci at the beginning of sentences (where 
capitalization is required by convention). Use an 
en-dash to indicate a range of teeth, e.g., M1–M3.
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REFERENCE STYLE
The obvious goal of listing references is to 

provide documentary support for statements 
made elsewhere in the manuscript. In the AMNH 
system, publications are listed alphabetically 
by author(s), with exceptions as noted below to 
facilitate information retrieval. 

Sequence for Reference Entries

The following rules determine the sequence in 
which publications should appear in the References 
section:
 
1. List publications alphabetically by author, with 
exceptions as noted below. 

For example:

Ackery, P.R. 1988. Hostplants and classification: 
a review of nymphalid butterflies. Biological 
Journal of the Linnean Society 33: 95–203.

Bänziger, H. 1988. The heaviest tear drinkers: 
ecology and systematics of new and unusual 
notodontid moths. Natural History Bulletin 
of the Siam Society 36: 17–53.

2. Multiple publications by the same author, 
or by the same two authors, should be ordered 
chronologically.

For example:

MacIndoo, N.E. 1917. The olfactory organs of 
Lepidoptera. Journal of Morphology 29: 33–
54.

MacIndoo, N.E. 1929. Tropisms and sense organs 
of Lepidoptera. Smithsonian Miscellaneous 
Collections 81: 1–59.

3. If there are multiple entries with the same author 
and date (or with the same two coauthors and 
date), distinguish these with lowercase alphabetic 
suffixes in the order in which they are cited in the 
text. For example, if Bänziger’s (1988) paper on 
blood-sucking moths was cited in the text before 
his coeval paper on tear-drinking moths, the 
reference entries should appear as: 

Bänziger, H. 1988a. Skin-piercing blood-sucking 
moths. V. Attacks on man by 5 Calyptra spp. 
(Lepidoptera, Noctuidae) in S and SE Asia. 
Mitteilungen der Schweizerishen Entomolo-
gischen Gesellschaft 62: 215–233.

Bänziger, H. 1988b. The heaviest tear drinkers: ecol-
ogy and systematics of new and unusual noto-
dontid moths. Natural History Bulletin of the 
Siam Society 36: 17–53.

4. List two-authored publications immediately after 
any single-authored publications by the first author, 
and list publications with three or more authors 
after any two-authored works with the same first 
author.

For example:

Brower, A.V.Z. 2000. Parallel race formation and the 
evolution of mimicry in Heliconius butterflies: 
a phylogenetic hypothesis from mitochondrial 
DNA sequences. Evolution 50: 195–221.

Brower, A.V.Z., and M.K. Auweyida. 2000. Phylo-
genetic relationships among the Nymphalidae 
(Lepidoptera) inferred from partial sequences 
of the wingless gene. Proceedings of the Royal 
Society of London Series B Biological Sciences 
267: 1201–1211.

Brower, A.V.Z., M.K. Auweyida, and M.G. Egan. 
2000. Cladistic analysis of Heliconius butter-
flies and relatives (Nymphalidae: Heliconiiti): a 
revised phylogenetic position for Eueides based 
on sequences from mtDNA and a nuclear gene. 
Proceedings of the Royal Society of London 
Series B Biological Sciences 264: 969–977.

 
5. Publications with three or more authors and the 
same first author (indistinguishably cited in the text 
by the first author’s family name followed by “et al.”) 
should be ordered by date, regardless of alphabetic 
sequence and numbers of authors. Use alphabetic 
suffixes in the order of citation to distinguish any 
with the same date. 

For example: 

Wible, J.R., G.W. Rougier, M.J. Novacek, M.C. 
McKenna, and D. Dashveg. 1995. A mammalian 

Section 4
References and Index
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petrosal from the Early Cretaceous of 
Mongolia: implications for the evolution of the 
mammalian ear. American Museum Novitates 
3149: 1–19.

Wible, J.R., M.J. Novacek, and G.W. Rougier. 2004. 
New data on the skull and dentition of the 
Mongolian Cretaceous eutherian mammal 
Zalambdalestes. Bulletin of the American 
Museum of Natural History 281: 1–144. 

Wible, J.R., G.W. Rougier, M.J. Novacek, and R.J. 
Asher. 2007. Cretaceous eutherians and 
Laurasian origin for placental mammals. 
Nature 447: 1003–1006.

Multiple authors. If a work has five or fewer 
authors, all authors should be named. If there are six 
or more coauthors, only the first author should be 
cited, followed by “et al.” For example, the following 
paper has seven authors, but should be cited as:

Dingus, L., et al. 2008. The Geology of Ukhaa Tolgod 
(Djadokhta Formation, Upper Cretaceous, 
Nemegt Basin, Mongolia). American Museum 
Novitates 3616: 1–40.

Date

Date of publication. The date (year of 
publication) should follow the name(s) of the 
author(s) in each reference entry. Use alphabetic 
suffixes (a, b, c. . .) to distinguish entries with 
the same authorship and date as cited in the text 
(rule 3; above). The date cited in the text should 
coincide exactly with the date in the bibliography. 
For example, if a span of years is given for several 
volumes of a publication, the same must be used in 
the text citation. 

When the actual date of publication is known 
to differ from the typographic (printed) date, that 
date should be the first cited in the reference list 
and the typographic/incorrect date should be 
placed in quotes in parens after the actual date, e.g.:

Gardner, A.L. (editor). 2008 (“2007”). Mammals 
of South America. Vol. 1: Marsupials, 
xenarthrans, shrews, and bats. Chicago: 
University of Chicago Press.

The in-text citation should include only the actual 
print date, not the typographic/incorrect one.

Use a question mark in square brackets to 
indicate a questionable date (e.g., Smith, 1926[?]). 

Works without dates. Use “In press” as 
a date for an upcoming publication only if the 
material has been accepted for publication. Use 
“ms.” for unpublished manuscripts on file or “to 
be published” (such as manuscripts under review, 
and so on). Use “in prep.” for work that is not yet 
completed.

Dates should be supplied for Ph.D. dissertations 
and master’s theses unless it is necessary to 
emphasize the fact that the work in question is 
officially unpublished for purposes of taxonomic 
nomenclature. In the latter case, list “ms.” in place 
of the date and supply the date at the end of the 
reference. The abbreviation “mss.” can be used in 
place of dates for two or more unpublished items. 
For undated official documents, “n.d.” (no date) 
should be used. Specify where the unpublished 
material can be located following the title (e.g., “ms. 
on file” or “Document on file” or “Paper presented 
at”).

Undated works should be placed before other 
reference items with the same authors(s).

Author

Authors’ names. Reverse only the first author’s 
name (family name first, initials last). Use initials 
for all given names unless different authors have 
the same family name and initials, in which case 
the first given name can be spelled out. Do not use 
a letter space between initials (e.g., J.A. Allen, not  
J. A. Allen). Separate authors names by commas. 
Use a comma before the “and” for two or more 
authors (see preceding examples).

Alphabetization. Sometimes rules of alpha-
betization are complicated because authors’ names 
are unusual; here is a sample of alphabetized names:

Auweyida, M.K.
Beethoven, L. von (family name commonly 

known without prefix)
d’Aubiac, B.
Delmore, E.
de Gaulle, C.
DiMaggio, G.
Ortega y Gasset, J.
Perle, A.
Rousseau, J.-J.
Rozen, J.R., Jr.
von Hindenberg, X. 
Yamaha, M. 
Zhou, M. 
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Prefixed names normally retain the prefix 
in front of the family name unless the name is 
commonly known without the prefix or the bearer’s 
preference is known to be otherwise. Text citations 
should agree with the listing in the References (e.g., 
if de Gaulle is cited in the text, the author should be 
listed under de Gaulle, not Gaulle).

Family name preceding given name. In Chi-
nese, Japanese, and Korean the family name tradi-
tionally precedes the given name, and in Mongo-
lian the patronymic (or matronymic) is used as a 
surname before the personal name. Authors should 
be sure that they have properly placed the family 
name in front of the given name in alphabetical 
lists that include Asian authors (e.g., publications 
by the Chinese paleomammalogist Meng Jin, com-
monly known among his American colleagues as 
Jin Meng, should be listed as authored by Meng, J.).

Names of Spanish origin. Names of Spanish 
origin often include the maternal family name 
(or a maternal-family initial) after the paternal 
family name, with or without an intervening 
hyphen. The paternal name should precede the 
maternal name (or initial) in an alphabetical 
listing, where hyphenating the compound helps 
avoid confusion:

Albuja-V., L., M. Ibarra, J. Urgilés, and R. Barriga. 
1980. Estudio preliminar de los vertebrados 
ecuatorianos. Quito: Escuela Politécnica 
Nacional.

Hernández-Camacho, J. 1956. Una subespecie 
nueva de Heteromys anomalus (Mammalia: 
Rodentia). Loziana 10: 1–15.

Acronyms in Place of Author/Anonymous 
Author: Publications issued by government agen-
cies, corporations, or other sponsor organizations 
may carry the name of the organization or its acro-
nym in place of the author, or an acronym may be 
used for a familiar work authored by committee:

ICZN. 1999. International code of zoological 
nomenclature, 4th ed. London: International 
Trust for Zoological Nomenclature.

IGM. 1978. Papallacta, ÑIII-B4c [1:25,000 topo-
graphic map]. Quito: Instituto Geográfico 
Militar.

Occasionally, if no author can be determined, 
the publication may be listed under “Anon.” (= 
anonymous).

Title

Follow these rules for the titles of cited 
references:

1. Capitalize only the first word and proper nouns 
for English-language works. For Western European 
languages using the Latin alphabet, follow the ac-
cepted style adopted for that language (see Chi-
cago Manual (16th ed.), 534–558, for recommen-
dations); when in doubt use the “down” style. For 
trans-literated languages, it is preferable to adopt a 
down style—the first word only is capitalized (that 
is, even proper names are lowercased). 

2. In general, do not abbreviate. However, it is 
permissible to shorten excessively long titles by 
omitting words and substituting ellipsis points  
(. . .) or other indications of abridgement for each 
deleted part:

Eden, R. 1555. The Decades of the newe worlde 
or west India, conteynyng the navigations 
and conquests of the Spanyardes, with the 
particular description of the moste ryche 
and large landes and Ilandes lately founde 
in the west Ocean [etc.]. Londini: In aedibus 
Guilhelmi Powell.

3. End each title with a period.

4. Carefully check all diacritical marks against 
original citations.

5. For books, identifying information such as 
volume, edition, translator, etc., should follow the 
title separated by a comma.

Serial Publications

Identifying information. Do not use any 
punctuation between the serial title and volume 
number. If necessary (see below), information 
subordinate to the volume number (number, part, 
article, etc.) should follow the volume number in 
parentheses. In general, identifying information 
should always be given in the proper order: most 
inclusive (normally the volume number) to less 
inclusive units proceeding from left to right. 

Identifying the issue. Journals that are 
paginated anew in each issue must identify the issue. 
However, if a journal is paginated consecutively 
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throughout the volume, identifying the issue is not 
required because the material can be located via the 
page numbers, but if an author chooses to supply 
issue identification consistently throughout the 
bibliography it will not be deleted.

The identifying information for a particular 
serial publication must be identical throughout the 
bibliography.

Series information. Some periodicals are (or 
were; the practice is now less common) published 
in series that included independently numbered 
sets of volumes. Information about series must 
follow the serial title parenthetically and precede 
the volume number as in these examples:

Hershkovitz, P. 1999. Domiciops gliroides Thomas, 
1894, last of the Microbiotheria (Marsupialia), 
with a review of the family Microbiotheriidae. 
Fieldiana Zoology (new ser.) 93: 1–60. 

Thomas, O. 1923. The geographical races of 
Lutreolina crassicaudata. Annals and Magazine 
of Natural History (ser. 9) 11: 583–585. 

Page numbers. Page numbers are separated 
from the previous information by a colon. Use 
inclusive page numbers separated by an en-
dash, e.g., 189–243. If pagination is complete in 
the work cited, supply the total page range (e.g., 
“1–423”).

Listing illustrative material. It is not nec-
essary to list figures, plates, maps, tables, or other 
illustrative material unless they cannot be found 
within the stated range of pages. However, on oc-
casion, authors may have valid reasons for listing 
such information. If illustrative material is consis-
tently included throughout the bibliography, this 
information will not be deleted without consulting 
the author.
 

Books

Location, publisher. This information is 
separated from the preceding information by a pe-
riod. Supply the city where published (plus state 
abbreviation or the name of the country, if the city 
is not well known) followed by a colon and then 
the publisher’s name. If more than one city is listed 
by the publisher, use only the first one. Shorten fa-
miliar publisher’s names (e.g., Wiley, not John Wi-
ley & Sons, Inc.).

Pagination, illustrative material. It is not 
necessary to supply the number of pages, illustra-

tions, etc., of a book (except for page ranges in a 
component reference; see below). However, if this 
material is included throughout, it will not be re-
moved without consulting the author.

Component, or Contributed, References

Component references are contributions to a 
larger work that are listed under the name of the 
contributing author. Use the following examples as 
guides:

Gardner, A.L. 2005. Order Didelphimorphia. 
In D.E. Wilson and D.M. Reeder (editors), 
Mammal species of the world, a taxonomic 
and geographic reference, 3rd ed.: 3–18. 
Baltimore: Johns Hopkins University Press.

Solari, S. 2003. Diversity and distribution of Thy-
lamys (Didelphidae) in South America, with 
emphasis on species from the western side 
of the Andes. In M.E. Jones, C.R. Dickman, 
and M. Archer (editors), Predators with 
pouches: the biology of carnivorous marsu-
pials: 82–101. Melbourne: CSIRO Press. 

Stein, B.R., and J.L. Patton. 2008a (“2007”). Genus 
Chironectes Illiger, 1811. In A.L. Gardner 
(editor), Mammals of South America. Vol. 1: 
14–17. Chicago: Chicago University Press.

Note that the name(s) of the author(s) or editor(s) 
of the larger work are not reversed. 

There are times when component references 
are complicated. Use common sense in presenting 
necessary bibliographic in a form that is most 
helpful to the reader.

Proceedings, Meetings, Conferences, 
etc. A conference paper may be listed in the 
References in one of three formats: if unpublished, 
use unpublished format; if published in a serial, use 
serial format; or if published as a “one time only 
event,” use book format).

Early Works

Some early works are hard to find, difficult to 
cite unambiguously (because dates and/or author-
ship are obscure), or present other noteworthy ir-
regularities that prevent standard citation style. 
Supplementary bibliographic information that 
may be helpful to readers who wish to consult such 
works may be included in square brackets at the 
end of the reference entry:
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Azara, F. de. 1802. Apuntamientos para la historia 
natural de los quadrúpedos del Paragüay y 
Río de la Plata [2 vols.]. Madrid: Imprenta de 
la Viuda de Ibarra. [Reprinted in the series 
“Biologists and their world” in 1978 by Arno 
Press, New York.]

des Marchais, C. 1730. Voyage du Chevalier 
des Marchais en Guinée, isles voisines, et à 
Cayenne, fait en 1725, 1726 & 1727 (4 vols.). 
Paris: Chez Pierre Prault. [This work, invariably 
cited as by des Marchais, was actually authored 
by J. B. Labat.]

Tschudi, J. J. von. 1844–1846. Untersuchungen über 
die Fauna Peruana. St. Gallen: von Scheitlin 
und Zollikofer. [Mammalian accounts 
published in different years as follows: pp. 
1–76 in 1844, pp. 77–244 in 1845; pp. 245–262 
in 1846; see Sherborn, 1922.]

Websites

Websites are increasingly cited as sources of 
scientific information as more data are moved on-
line. However, electronic archiving is often prob-
lematic: online resources cited by authors may 
subsequently be altered or removed, and URLs 
change frequently. Therefore, unless hosting or-
ganizations are committed to maintaining a per-
manent web-based repository for unaltered docu-
ments, electronic media are essentially similar to 
such other cited ephemera as personal communi-
cations or unpublished manuscripts.

Ideally, citations of web-based documents in 
the References section should include the author(s) 
names(s), publication (or copyright) date, and the 
title of the page on which the cited information 
appears (rather than a home page). The identifying 
phrase “Internet resource” should be followed by a 
URL or URN (in parentheses) and the most recent 

date the page was accessed by the author:

Auweyida, M.K. 2009. New lizards of Nauru. 
Arubo, Nauru: Kayser College. Internet re-
source (http://auweyida_lizards.nr), accessed  
January 4, 2009.

Some web-based documents are found through 
a digital object identifier (doi), and this type of 
citation should be placed in brackets at the end 
of the citation, after the period and without final 
punctuation (i.e., another period):

Tejedor, A. 2011. Systematics of funnel-eared 
bats (Chiroptera: Natalidae). Bulletin of the 
American Museum of Natural History 353: 
1–140. [doi: 10.1206/636.1]

It is the responsibility of authors to include this 
information in the References. At this time, in-
clusion of a doi citation is optional.

Unpublished Material

Authors should not list unpublished material 
in the References unless they can specify where 
that material can be located. Unarchived letters, 
manuscripts not yet submitted to any publisher, 
and other forms of personal communication are 
best cited in the text only. 

INDEX

Authors must supply any index that is to be 
published with their work. Because an index is 
not sent to the printer until final page numbers 
are inserted, no index should be submitted with 
the manuscript. It is helpful, however, for authors 
to indicate that an index is forthcoming. 
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Section 5
Tables

Tables (except very simple ones with columns 
separated by single tabs) should be created using 
Excel or Word’s drop-down “Table” menu. Printed 
copies should allow sufficient space between col-
umns of data for easy reading by reviewers, and no 
more than one table should be placed on a manu-
script page. All tables must be numbered, titled, 
and placed at the end of the manuscript (see Order 
of Materials, above). Authors should indicate the 
best location for each table in the published docu-
ment by marking the table number in the margin 
of the manuscript at each preferred location.

Inconsistently and inappropriately styled and 
formatted tables are the cause of many time-con-
suming delays in the production process. Authors 
are encouraged to consult recent issues of AMNH 
publications for relevant examples of acceptable 
table layouts.

CONCISE PRESENTATION

Like artwork, tables can usefully summarize a 
variety of complex information, including statisti-
cal results that cannot reasonably be enumerated 
in the text. However, tables should present data as 
concisely as possible. Avoid large numbers of blank 
(no data) entries. If data for a proposed column are 
sparse, summarize these results concisely in a few 
sentences in the text or in a table footnote instead 
of creating a separate column. Information to be 
included in a table should be carefully selected. Do 
not repeat data already present in the text.

Concise headings. Table headings should be 
as concise as possible. Authors should pay special 
attention to condensing column headings, all of 
which must fit within the width of a page. In par-
ticular, authors should abbreviate long headings 
over narrow columns of data and spell out the ab-
breviation in a table key or footnote. Do not type 
headings vertically on the page. To avoid congested 
or layered column headings, it may be preferable 
to arrange the data in two or more separate tables. 
Row (stub) headings can be controlled to a certain 
extent by indenting subordinate information on 
subsequent lines.

Intelligible abbreviations (e.g., “usu.” for “usu-
ally”) and grammatical symbols (e.g., the amper-
sand [&] for “and”) that are not permissible else-
where in the manuscript may be used in tables if 
necessary. However, tabular abbreviations should 
be consistent throughout the manuscript, and the 
author should arrange similar data the same way 
in all tables. 

FORMAT

In general, avoid meaningless clutter. Do not 
apply decorative features (e.g., borders). Do not 
use blank rows or columns to create extra “space.” 
Do not use boldface or italic typefaces to make the 
table headings “look better.” Do not use shading 
unnecessarily. 

Table titles and introductory para-
graph(s). Center the word TABLE and its number. 
The title, which begins on the next line, should be 
in boldface and should not end in a period. Avoid 
long titles; detailed information is ideally present-
ed in a paragraph following the title (also centered 
but with regular style type instead of boldface).

Authors may choose to (1) capitalize the first 
word of the title and proper nouns only or (2) capi-
talize all words except articles, prepositions, and 
conjunctions having fewer than four letters. How-
ever, all table titles should be consistently format-
ted. If authors are inconsistent, the “down” style 
(1) will be applied. 

In-table footnotes. For table footnotes in 
Novitates and Bulletin, superscripted lower-case 
letters (a, b, c . . .) are preferable to numbers to 
avoid confusion with text footnotes and to avoid 
semantic ambiguities when numerical entries have 
numerical superscripts (for example, “512” could 
be read as the product 51×51). Authors of manu-
scripts intended for Novitates and the Bulletin 
should not use embedded table footnotes.

For Anthropological Papers authors, table foot-
notes may be embedded and they take the normal 
1, 2, 3. . . style, unless a majority of the tables in a 
monograph will be numerical data only.

Table headings. Column and horizontal row 
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headings should be brief and clear; normally they 
should NOT be italicized, unless they are names of 
genera or species. Boldface should be not be used in 
headings except under exceptional circumstances; 
consult with the Managing Editor.

SIZING TABLES

Considering the dimensions of a page, keep in 
mind the fact that a long narrow table is often pref-
erable to a short, wide one. Row headings can be 
continued on a subsequent page. 

The number of columns across the page is limited 
by the width of the page. Columns (specifically, the 
widest line in the table) must fit across the printed 
publication in one of the following ways: (1) across a 
single two-column page, (2) broadside (page turned 
sideways because table is too wide to fit straight up), 
or (3) across two facing pages. 

If necessary, the printer may resort to a smaller 
typeface in order to fit the table to the width of the 
page, but type may not be infinitesimally small. 
Tables that are too large will be included as supple-
mentary materials available on the web; see web 
options, below (this section). 

Squeezing tables into a narrower space. 
If the width of a table is likely to exceed page 
width, the author should try a different format. 
The following methods should be considered 
(there may be others depending on the nature of 
the particular table): 

1. Remove redundant information. Authors fre-
quently submit tables with a variety of redundancies, 
such as a column-head word reused in each row.  

2. Combine columns. Can the data in adjacent 
columns be combined without loss of clarity? For 
example, separate columns for sample mean, ob-
served range, and sample size could be combined 
into one column with statistics separated by punc-
tuation (e.g., parentheses).

2. Eliminate unnecessary columns, especially 
those with little or no data. Scanty or nonessential 
data might be explained in a table footnote or in 
the text.

3. Transpose table columns and rows. However, 
all tables with similar content must present data in 
a consistent fashion, so if one table of taxon mea-
surement data has transposed columns and rows, 
all must follow the same template.

Web options. Scientific Publications can now 
easily archive supplementary data for the Bulletin, 
the Novitates, and  Anthropological Papers on the 
Library’s D-space with permanent cyberspace lo-
cators (dois). Tables more than a couple of pages 
in length or that have too many columns to rea-
sonably fit on a printed page will not be printed; 
such tables will be assigned a doi and posted on the 
Library’s D-space.

Large data matrices—any larger than two 
printed pages—should be deposited in public ar-
chives such as GenBank, MorphoBank, TreeBase, 
Dryad, etc., prior to manuscript submission. (See 
Submission Guidelines.) Likewise, new material 
("addenda") and significant corrections ("corrigen-
da") relating to an issue number already published 
may be made available as supplementary data with 
a doi posted on D-space.

http://research.amnh.org/scipubs/submission-guidelines
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Section 6
Illustrations

High-quality illustrations have long been a pri-
mary objective in the three AMNH scientific series. 
Contributing authors should submit professionally 
prepared illustration e-files. Ideally, these should 
be submitted either as layered Photoshop-readable 
files (.tif or .psd) or as native Illustrator (.ai or .eps) 
files (see File types and size). 

ECONOMICAL ILLUSTRATIONS

Illustrations occupy valuable page space and 
thus should be kept to a minimum. Each one 
should bear relevance to the text. Resist the temp-
tation to include repetitious photographs simply 
because they are “good shots” or to create needless 
graphics—so-called chart junk (see fig. 1). 

First-time authors might find Edward Tufte’s 
books helpful for conceptualizing the graphical 
summary of scientific information: The Visual Dis-
play of Quantitative Information (1983), Envisioning 
Information (1990), and Visual Explanations (1997).

Placement. Normally, images are placed near 
the first place where they are cited in the text. Au-
thors may indicate alternative placements for fig-
ures, if the first-citation location is not suitable, by 
noting the figure number in the e-file of the manu-
script at the proper location, enclosing the figure 
number in a double set of square brackets, e.g., 
[[FIG. 23 HERE]].

Grouping. Related figures should be grouped 
together into a unit (herein called a plate to dis-
tinguish it from the individual subimages) wher-
ever possible for the most economical presenta-
tion. Uninformative black or white space within 
the rectangular area that the illustrations occupy 
should be kept to a minimum. (Occasionally, how-
ever, an odd number of figures must be grouped 
together into an arrangement that makes it virtu-
ally impossible to avoid an area of blank space.) 

 Position internal identifiers in the upper left-
hand corner of each subimage of a drawing or 
photograph. Numbers (or letters) can be black 
or white on the same plate depending on what 
contrasts best with the background of the figure. 

 Subimage identifiers may be: either (1) capital 

letters (fig. 2, opposite page) or (2) sequential figure 
numbers (fig. 3, page 28). Whether option (1) or 
(2) is adopted, the main reference to each subimage 
in the legend/caption should highlight its label 
number or letter in boldface.

The final size of the illustration should be taken 
into account when selecting the size of these 

Fig. 1. A sterling example of “chart junk,” unnecessary 
graphics when a few words of text will do. In place of 
this chart, a statement in the text “30% of experimental 
subjects died” is preferable. (Reprinted by permission of 
the artist; name withheld by request)
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numbers. They should be prominent enough to 
clearly identify the figure but not so bold that they 
“leap off the page” at the reader. A good final size 
for capital letters is 10 or 12 pt. Type should not be 
outlined (in Illustrator and similar software), as the 
size cannot be edited if necessary.

Illustration legends should be adequately infor-
mative but concise. Long captions (e.g., any exceed-
ing one-half of a manuscript page) can cause prob-
lems in page makeup. Long descriptions should be 
incorporated into the running text or into tables 
placed near the figure.

FILE TYPES AND SIZE

All artwork must be readable by Adobe 

Illustrator or Photoshop. Note that CorelDraw 
files can often be exported as Illustrator (.ai) files. 
At this time Scientific Publications cannot accept 
Freehand (.fh) illustrations. However, .pdf files of 
cladograms exported directly from WinClada are 
normally readable by Illustrator (consult with the 
Managing Editor).

Illustrator (ai. and .eps)

Because native Illustrator files are vector 
based, normally resolution is not an issue, but one 
should scale lines and effects so they will not be 
too thick or too thin when printed at their “right” 
size. Usually a cladogram line should be 1 pt, and 
should not be less than 0.75 pt. Care should also be 
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Fig. 2. Capital letters identify subimages on a single figure; the figure number does not need to appear on the figure 
itself, though it should appear in the image’s respective caption. (Novitates 3655 [2009]: fig. 12)
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taken when a photographic image (.tif) is dropped 
into Illustrator; that image must have appropriate 
resolution to print without pixellation.

Line Drawings

Line drawings not created in a vector-based 
program such as Illustrator need to be 1200 ppi for 

crisp reproduction (see Photoshop, below). Images 
should be sized for appropriate print size: There is 
no need to have large line drawings if there is no 
internal detail (but all drawings, whatever the size, 
need to be of high resolution, 1200 ppi). 

Use scale bars for comparisons across figures 
and subimages rather than supersizing a simple 
drawing.

Fig. 3. Figure numbers identify subimages on this plate. The “caption and legend” that accompany this plate should 
incorporate descriptions of “Figures 52–59.” (Novitates 3625 [2008]: figs. 52–59)
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Photoshop (.tif and .psd)

Because Photoshop files are pixel based, 
checking resolution and size is critical. Color and 
gray scale (halftone) photographs must be at least 
300 pixels per inch (ppi), and line drawings must 
be 1200 ppi for cl.

Here’s a simple way to check: In Photoshop’s 
drop-down menu, go to Image>Image Size. This 
opens a panel of Pixel Dimensions, Document 
Size, and Resolution (see fig. 4).

An image’s resolution may be appropriate, but 
the “Document Size” indicates that the image will 
print at postage-stamp size. DO NOT “Resample 
Image”! This will NOT solve the problem (fig. 5). 

A resampled low-resolution image cannot 
be printed (unless it is supposed to be the size 
of a postage stamp), and will need to be remade. 
Usually, images downloaded from the Internet do 
not have sufficient resolution for printing.

A rule of thumb: If a photograph were to be 
printed at maximum size (5.75″ × 8″ ) at minimum 
resolution, it should be at least 1725 × 2400 pixels, 
yielding a file size of roughly 11.8 MB. But ideally 
photographic images should be 600 ppi.

 
The Gutenberg Rule

NO PRINTER can improve the quality of any 
image you submit. If your image is poor, that’s 
exactly how it will print—it’s better to remake your 
image.

RGB or CMYK

Because color work must be paid for by authors 
it is their responsibility to provide a high-quality 
color print for each color image to be printed, what 
we call a color match because it gives the printers 
something to match with their system. The file type 
may be RGB or CMYK, but note that the printer 
will convert any RGB files to CMYK, which may 
result in a loss in the intensity of reds, greens, and 
blues in particular in the printed version (some 
degree of these colors are replaced by proportional 
degrees of black).

SIZING ARTWORK

Even before figures are drawn or photographs 
are labeled, the final printed size of the illustrations 
should be considered. Artwork should be 
conceived (and printed) at its “right size”—though 
one must bear in mind the maximum dimensions 
of art and legend together (5.75″ × 8″). At right 
size, illustrations convey the greatest amount 
of information and because the type is neither 
too small nor too large readers can focus on 
comprehending that graphic knowledge without 
obstacles.

The maximum width of art on a page is 5.75 
inches. The maximum depth is 8 inches with 
caption included (note that the term caption is 
used in this manual to apply to both caption and 
legend). In exceptional circumstances SciPubs 
may consider an occasional bleed (i.e., running 
outside width and depth margins), if it is needed to 
convey scientific information. Please consult with 
the Managing Editor.

Fig. 4. The Image Size panel of Photoshop. Although 
the resolution is sufficient, note that the image itself is 
only about an inch on a side, too small to print.

Fig. 5. When printed at normal size (e.g., 3–4 inches 
on a side), the one-inch image will become blotchy and 
pixellated, as seen at right. (Photograph by M. Knight)



30	  Section 6 / ILLUSTRATIONS� AMNH

The maximum width of art in a column is 2.75 
inches. Maximum depth is 8 inches with caption 
included. 

Caption calculus. Calculating caption (leg-
end) depth: If you are preparing artwork for a full 
page, you will probably want to know how much 
space its caption will take so you can properly right-
size the artwork. If you are working with an artist, 
you may alert him/her that the specs are 9 on 10 
Times Roman at 2.75, 5.75, or 8 inches in width. If 
you are, sadly, bereft of an artist, tables 1–3 provide 
a rough but handy guide to caption depth (in mm).

LABELS

Once all the artwork for an article has been 
sized to fit on the page with its caption, labels can 

be added or (if they are already on the layered 
artwork) sized.

Label fonts. Labels on artwork should be all 
in Arial or all in Helvetica; under certain circum-
stances, another sans serif font may be substituted; 
consult the Managing Editor. 

Use capital letters for identifying components 
on a single plate, A, B, C. . . . They are easier to 
distinguish from lowercase letters and thus can be 
in a smaller size (no more than 12 pt ideally).

For nonalphabetical labels (e.g., those that 
identify anatomical parts), either capitals or 
lowercase labels are acceptable, but every ef-
fort should be made to make them consistent 
throughout an entire work. (Exception: if lower-
case letters are used, it is appropriate to use capi-
talized acronyms.)

Characters	                 Lines		  Depth		  Maximum Height of Art
			   inches (mm)		  in inches
	
≤ 95	                1		  0.28 (7.175)		  7.72
96–195	                2		  0.42 (10.703)		  7.58
196–295	                3		  0.56 (14.231)		  7.44
296–395	                4		  0.70 (17.759)		  7.30
396–495	                5		  0.84 (21.287)		  7.16
496–595	                6		  1.00 (24.8148)		  7.02

TABLE 1
Illustrations 2.76″–5.75″ width

Depth of the first line of text is higher than successive lines because there is white space between the art 
and the legend (about 0.16 inches / 4 mm). Ideally, no caption should have a depth greater than six lines 

(about 600 characters), if possible; authors should redirect material to the body of the text.

TABLE 2
Illustrations with a maximum 2.75″ width

Characters	                 Lines		  Depth		  Maximum Height of Art
			   inches (mm)		  in inches
	
≤ 50	                1		  0.28 (7.175)		  7.72
51–100	                2		  0.42 (10.703)		  7.58
101–150	                3		  0.56 (14.231)		  7.44
151–200	                4		  0.70 (17.759)		  7.30
201–250	                5		  0.84 (21.287)		  7.16
251–300	                6		  1.00 (24.8148)		  7.02
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Label style. Regular type is preferred, except 
as necessary. Italics should not appear for decora-
tive purposes; do not use italics on labels unless 
the label is italicized in the text. Exception: italics 
are properly used for the names of bodies of water 
on maps, because it distinguishes them at a glance 
from land areas.

Labels may be regular or boldface, depending 
on the “weight” of the art on which it is placed. 
That is, if one illustration needs the weight of bold-
face for clarity, then that illustration may dictate 
that all the illustrations for the article should like-
wise have boldface labels. On the other hand, it 
may be better to use a regular style and add mini-
mal drop shadow to the lone illustration that os-
tensibly “needs” boldface. 

An author should always keep in mind that il-
lustrations are all about conveying information vi-
sually, and thus art should take preeminence over 
the words of an illustration. Boldface type can dis-
tract from the scientific content of the illustration, 
and if so, regular style should be used or perhaps 
the labels should be reduced in size (normal mini-
mum size is 8 pt; see Label size, next topic) or in 
number.

Label size. Some consideration must be given 
to the final size of the illustrations before they are 
labeled. Labels should normally be no less than 8 
pt and no more than 12 pt. The smallest acceptable 
size is 6 pt (which is often necessary when numbers 
are used on cladograms). All illustrations for a 
single work should be planned in advance so that 
the labels are identical in size and font. 

If the labels run into each other at a legible size, 
it may be necessary to remove some of them or re-
conceptualize the art—art is not a substitute for 

text. Alternatively, some illustrations are necessar-
ily label heavy, e.g., cladograms. If so much textual 
information is included that labels are crowded 
and type falls below standard size, a foldout may 
be the solution, though the cost for this is at the 
expense of the author. If a foldout is not an option, 
authors should reconceptualize such illustrations 
(e.g., into smaller parts) or they will need to place 
their oversize work as a supplement to the publica-
tion on the web (i.e., the illustrations in question 
will not appear in print, but the doi to the file or 
files will be published in the body of the work.)

Labels of the same “level” of information should 
be the same size. For example, for a series of plates 
with subimages, all alphabetical labels (A, B, C. . .) 
might be 12 pt, while anatomical parts might be 10 
pt, and the scale bar (e.g., 10 mm) might be 8 pt.

Label placement. Alphabetical (A, B, C...) and 
numerical labels should be placed in the upper left-
hand corner of their respective subimages.

Image titles. Authors should avoid unnecessary 
titles on the illustrations themselves. Such titles will 
be deleted if they repeat information in the figure 
legends.

Image borders. Usually borders are not nec-
essary. However, sometimes maps have a cleaner 
look with a simple 1 pt black border. Larger than 
this detracts from the image within the border.

Magnifications and scale bars. Scale bars, 
with the measurement on the art, are preferable 
to magnifications. This avoids the problem of al-
tering magnifications specified in figure legends 
if the illustration is reduced to a size other than 
that originally planned. Units of measurement on 
scale bars should have one letter space between the 
number and the unit, e.g., 1 mm.

TABLE 3
Illustrations up to 8.0″ width

For artwork that must be placed lengthwise on the page so the legend is perpendicular to the top of the 
page, the width is 8 inches.

Characters	                 Lines		  Depth		  Maximum Height of Art
			   inches (mm)		  in inches
	
≤ 140	                1		  0.28 (7.175)		  5.47
141–290	                2		  0.42 (10.703)		  5.33
291–440	                3		  0.56 (14.231)		  5.19
441–590	                4		  0.70 (17.759)		  5.05
591–740	                5		  0.84 (21.287)		  4.95
741–890	                6		  1.00 (24.8148)		  4.75
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Charts and graphs

Avoid chart junk, unnecessary labels, data, or 
decorations. Icons on charts and graphs should be 
simple and tasteful (e.g., circles, triangles, squares, 
and the like) so as not to distract from the scientific 
content.

The less “junk” on a chart or graph the easier 
it is for readers to grasp the data. For example, 
avoid labeling every tick on the x- or y-axis if the 
increments are readily apparent with fewer labels. 
Delete unnecessary panels or labels—but do provide 
appropriate level of detail on those items that remain.

Use standardized icons for the discipline. For 
example, for geology, we prefer USGS symbols 
(FGDC Digital Cartographic Standard for Geologic 
Map Symbolization, available at http://pubs.usgs.

gov/tm/2006/11A02/).
If icons are used in an illustration, e.g., on a map, 

include a key of the symbols.

Cladograms

Like other illustrations, cladograms need to fit 
handily on the printed page (see Sizing artwork), 
and labels cannot be excessively small for the 
printed document (see Label size). Cladograms 
may need to be broken into smaller components 
that run over several pages or they may be better 
printed on a foldout. Authors are responsible for 
paying foldout charges; note that both sides of 
foldouts are printable. Consult with the Editor for 
current options and price estimates if a foldout is 
under consideration.
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